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Abstract

These Application Notes present sample configurations for Remote User access to Avaya
telephony products via VPN IPSEC and VPN SSL tunnel connections. The Avaya Products
used in these Application Notes include, Avaya 9620 IP VPN desk phone, Avaya one-X®
Mobile, Avaya one-X® Communicator. Each Avaya client registers to Avaya Aura™
Communication Manager. IPSEC tunnel connection service was configured on a Cisco ISR
2811. The SSL tunnel connection service was configured on a Cisco ASA 5510.
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1. Introduction

These Applications Notes describe the steps to configure Remote User access to an Avaya
telephony network via VPN-IPSEC and VPN-SSL tunneling. The secure connection allows the
Remote User the experience of having regular office telephony services available at home via
their home internet connection. The type of connection choice depends on the Avaya product
used. The Avaya one-X™ Deskphone Edition supports VPN-IPSEC. Avaya one-X Portal and
Avaya one-X Communicator support VPN-IPSEC and VPN-SSL.. For this sample configuration,
a Cisco Integrated Services Router (ISR) 2811 was used as the IPSEC gateway, and a Cisco
Adaptive Security Appliances (ASA) 5510 was used as an SSL gateway.
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Figure 1: Network Overview of Remote User Client Connection
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The Remote User has a standard broadband connection to the internet. A tunnel connection is
established to external IP address of the VPN gateway, at which point an inner IP address is
assigned to the Remote User’s PC and / or 96xx endpoint, allowing access to Avaya Aura™
Communication Manager, and the Avaya one-X® Portal Server which reside on the internal

network.

Avaya IP telephone models supporting the Avaya 96xx Series IP Telephone VPN firmware

include the 9620, 9620C, 9620L, 9630, 9640, 9650, 9650C and 9670. The Avaya 9610 does not

support VPN.

2. Equipment and Software Validated

The following equipment and software were used for the sample configuration provided.

Product / Hardware Platform

Software Version

Avaya IP Telephones (9620)

R3.1

Avaya S8730 Server

Avaya Aura"" Communication Manager 5.2.1

Avaya G650 Media Gateway

e TN2312BP HW15 FW049
e TN2602AP HW08 FW049
e TN799DP HWO01 FW034

Avaya one-X® Portal Server 5.2.0.0.18
Remote User Computer Avaya one-X® Communicator
5.2.0.0.10

MS Windows XP Version 2002 SP3

Avaya MBT Platform S8800

Midsize Business Template 5.2.1.2.5
Avaya Aura™ Application Enablement Server
R5-2-0-98-0

Cisco ISR 2811

c2800nm-adventerprisek9 ivs-mz.124-24.T .bin

Cisco VPN-IPSEC Client
Version 5.0.06.0110

Cisco ASA 5510 8.2(1)11
Cisco VPN-SSL Client
Version 1.1.4.179
Table 1 — Equipment and Software Validated
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3. Configure Avaya Aura™ Communication Manager

This section provides the procedures for configuring Communication Manager on the following
areas:

e |IP Codec Sets Configuration

e [P Network Map Configuration

e [P Network Region Configuration

e Adding station for the remote user

It is assumed that the Communication Manager has been installed, configured, licensed and
provided with a functional dial plan. Refer to Section 7 Reference [1] for more details.
Throughout this section the administration of Communication Manager is performed using a
System Access Terminal (SAT). The commands are entered on the system with the appropriate
administrative permissions. Some administration screens have been abbreviated for clarity. The
Remote User Avaya endpoints are assigned to IP Network Region 2 using the IP address range
of the VPN Client IP address pool defined on Cisco ISR and Cisco ASA. For proper bandwidth
management the G.729 codec is assigned to IP Network Region 2.

3.1. IP Codec Sets Configuration

Use the change ip-codec-set n command to configure IP Codec Set paramenters where n is the
IP Codec Set number. In these Application Notes IP Codec Set 1 was used for the Headquarter
network and IP Codec Set 2 for the remote user’s telephones. In order to configure the codec set
for the headquarter network region, use the command change ip-codec-set n command, where n
is codec set used in the configuration. Enter the following values:

e Audio Codec set for G.711MU

e Silence Suppression: Retain the default value n
e Frames Per Pkt: Enter 2

e Packet Size (ms): Enter 20

Retain the default values for the remaining fields, and submit these changes.

change ip-codec-set 1 Page 1 o0f 2
IP Codec Set

Codec Set: 1

Audio Silence Frames Packet
Codec Suppression Per Pkt Size(ms)
1: G.711MU n 2 20
2:
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For the Avaya 96xx Series IP Telephones a different codec set is used. Use the command change
ip-codec-set n command, where n is codec set used in the configuration. Enter the following
values:

e Audio Codec: set for G.729 needed to support 96xx Series IP Telephones
with VPN

e Silence Suppression: Retain the default value n

e Frames Per Pkt: Enter 3

e Packet Size (ms): Enter 30

The following screenshot shows the configuration of ip-codec-set 2 for the VPN users and
telephones.

change ip-codec-set 2 Page 1 o0f 2
IP Codec Set

Codec Set: 2

Audio Silence Frames Packet
Codec Suppression Per Pkt Size(ms)

1: G.729 n 3 30
2:

Use list ip-codec-set command to verify the codec assignments, as shown in the following
screen capture.

list ip-codec-set

IP CODEC SETS

Codec Codec 1 Codec 2 Codec 3 Codec 4 Codec 5
Set
1 G.711MU
2 G.729 G.711MU
3
4
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3.2. IP Network Map Configuration
Use the change ip-network-map command to define the IP address to Network Region mapping
for Avaya 96xx Series IP Telephones. The IP address range will be the same as configured on
the IP pool in the Cisco ISR for the VPN clients. Enter the following values:

e FROM: the beginning of the address range (in these notes 10.10.98.20)

e TO: the end of the address range (in these notes 10.10.98.120)

e Network Region:  the IP Network region used by 96xx Series IP Telephones with

VPN Telephones (in these notes 2 is used)
e Subnet Bits: Equivalent to netmask (in these notes 24 is used)

The following screenshot represents the association between the Cisco ISR IP Pool used for VPN
users and Network Region 2.

change ip-network-map Page 1 of 63
IP ADDRESS MAPPING
Subnet Network Emergency
IP Address Bits Region VLAN Location Ext
FROM: 10.10.98.0 /24 2 n
TO: 10.10.98.255
FROM: 10.10.97.0 /24 2 n

TO: 10.10.98.255

3.3. Configure IP Network Region

Use the change ip-network-region n, where n is the number of the network region used and set
the Intra-region IP-IP Direct Audio and Inter-region IP-1P Direct Audio fields to yes. For
the Codec Set enter the audio codec set corresponding to the remoter user’s telephones as
configured in Section 3.1. Retain the default values for the remaining fields, and submit these
changes.

change ip-network-region 2 Page 1 of 19
IP NETWORK REGION
Region: 2
Location: 1 Authoritative Domain: avaya.com
Name: HomeUsers
MEDIA PARAMETERS Intra-region IP-1P Direct Audio: yes
Codec Set: 2 Inter-region IP-1P Direct Audio: yes
UDP Port Min: 2048 IP Audio Hairpinning? n

UDP Port Max: 3329
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Navigate to Page 3 and ensure that the codec set 2 defined previously, is used when connecting
calls to dst rgn (region) 1 and 2. Use the SAT command save translation to save the
configuration changes.

change ip-network-region 2 Page 3 of 19
Source Region: 2 Inter Network Region Connection Management | M
G A e
dst codec direct WAN-BW-limits Video Intervening Dyn A G a
rgn set WAN Units Total Norm Prio Shr Regions CAC R L S
1 2 y NoLimit n all
2 2 all

3.4. Adding Stations for Remote Users

The Remote User stations for Avaya one-X Portal, Avaya one-X Communicator and Avaya 9620
Series IP Telephone with the VPN feature enabled, are administered as regular IP telephone
stations on Communication Manager. The following screens illustrate the extension
configuration for an Avaya 9620 Telephone added to the system using the command add station
20050. Enter the following values:

e Type: select 9620
e Name: Name for the extension (in these notes Test 20050 is used )
e Security Code: A security code (in these notes 1234 is used)
e IP SoftPhone? y
add station 20050 Page 1o0f 5
STATION
Extension: 20050 Lock Messages? n BCC: O
Type: 9620 Security Code: 1234 TN: 1
Port: S00054 Coverage Path 1: 1 COR: 1
Name: Test 20050 Coverage Path 2: CoS: 1

Hunt-to Station:
STATION OPTIONS
Time of Day Lock Table:

Loss Group: 19 Personalized Ringing Pattern: 1
Message Lamp Ext: 20050
Speakerphone: 2-way Mute Button Enabled? y
Display Language: english Button Modules: O
Survivable GK Node Name:
Survivable COR: internal Media Complex Ext:
Survivable Trunk Dest? y IP SoftPhone? y

IP Video Softphone? n
Customizable Labels? Y
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Navigate to Page 2, enable media shuffling by selecting
e Direct IP-IP Audio Connection? y

display station 20050 Page 2 of 5
STATION
FEATURE OPTIONS
LWC Reception: spe Auto Select Any ldle Appearance? n

LWC Activation? y Coverage Msg Retrieval? y
LWC Log External Calls? n Auto Answer:
none
CDR Privacy? n Data Restriction? n
Redirect Notification? y Idle Appearance Preference? n
Per Button Ring Control? n Bridged ldle Line Preference? n
Bridged Call Alerting? n Restrict Last Appearance? y
Active Station Ringing: single
EMU Login Allowed? n
H.320 Conversion? n Per Station CPN - Send Calling Number? y
Service Link Mode: as-needed EC500 State: disabled
Multimedia Mode: enhanced
MWI Served User Type: sip-adjunct Display Client Redirection?

Select Last Used Appearance?

Coverage After Forwarding?

Multimedia Early Answer?

Remote Softphone Emergency Calls:as-on-local Direct IP-1P Audio Connections?y
Emergency Location Ext: 20050 Always Use? n IP Audio Hairpinning? n

5 W0W 3 S

Submit these changes. Use the SAT command save translation to save the configuration
changes.
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3.5. Configuring Avaya 96xx Series IP Telephones with VPN Support

The Avaya 96xx Series IP Telephone configuration can be administered centrally from an HTTP
server through the 46xxsettings.txt file or locally on the phone. These Application Notes utilize
the local phone configuration method. VPN enabled firmware (R3.1) must be installed on the IP
phone before it can be configured.

3.5.1. During Telephone Boot

During the 96xx Series IP Telephone boot up, the “*” key can be used to enter the Configuration
mode as shown below.

100 Mbps Ethernet
* 10 program

(Please note that the * key can also be used to enter the configuration mode before the tunnel
building procedures are complete). When the * key is pressed, it will display Enter Code: Press
Mute Button followed by PROCPSWD (Please contact Avaya Support for password) and then
press # to Enter into the phone configuration mode. Go to ADDR (Address Procedures) and
update it with the below details.

0.0.0.0 (Will be assigned from the IP pool configured on the VPN
Phones IP Address gateway or by the Internal DHCP server if the VPN gateway is
configured as a DHCP Relay).

Call Servers IP Address | 135.64.186.7 (Communication Manager IP address).

Router IP Address 0.0.0.0 (Will be assigned by the DHCP server on the Home Gateway).
Subnet Mask 0.0.0.0 (Will be assigned by the DHCP server on the Home Gateway).

135.64.186.226 (Internal HTTP server IP address in dotted decimal
Http Server

format, which is serving the 46xxsetting.txt file).

A.B.C.D (Internal HTTPS server IP address in dotted decimal format

Hitps Server IP Address if it’s preferred delivering the configuration over HTTPS).

802.1Q Auto
VLAN ID 0
VLAN Test 60

Table 2 - Settings on Avaya 96xx Series telephones
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Press Exit to come out of the ADDR procedures. Scroll down to the last option: VPN. Note that
the VPN configuration parameters will not be edited until the value of VPNPROC parameter is
set to 2. To do this open the upload directory of the file server, open the file 46xxsettings.txt file
and add SET VPNPROC 2 and upload this new 46xxsettings.txt file into the Avaya 96xx Series
IP Telephone. It is recommended to set the value of VPNPROC to 2 while uploading the VPN
enabled binary into the telephone.

Use Right Navigation key to go to the next screen options. Note that the values will not be saved
until the Right-Navigation key is pressed even if Save button is pressed. The External
addresses will be reflected only after rebooting the telephone. The configuration values of one of
the 96xx Series IP Telephones used in the sample configurations are shown in Table 3 below.

No. Option Value
1 |VPN: Enabled
2 | VPN Vendor: Cisco
3 | Gateway Address: 172.16.1.1 (“External” interface IP address of VPN gateway)
4 | External Router: 0.0.0.0 (Or provided by dhcp from home Network).
5 i)étderrgg: Telephone IP 0.0.0.0 (Or Same as above).
6 | External Subnet Mask: | 0.0.0.0 (Or Same as above).
7 | External DNS Server: (Provided by Service provider).
8 | Encapsulation : 4500-4500
9 | Copy TOS: No
10 | Auth. Type: PSK with XAUTH
11 | VPN User Type: Any
12 | VPN User: (VPN username i.e. testphone?2 as per our notes)
13 | Password Type: Save in Flash
14 | User Password: *xkxx* (1., Remote password i.e. vpnpass as per our notes).
15 | IKE ID (Group Name): | (Group name i.e. groupauthor as per our notes).
16 | Pre-Shared Key (PSK) FxkxxA**F* (The preshared key defined in the gateway, vpnvpn
as per our notes).
17 | IKE ID Type: KEY_ID
18 | IKE Xchg Mode: Aggressive.
19 | IKE DH Group: 2
20 | IKE Encryption Alg: Any
21 | IKE Auth. Alg. : Any
22 | IKE Config. Mode: Enabled
23 | IPsec PFS DH Group: 2
24 | IPsec Encryption Alg: Any
25 | IPsec Auth. Alg.: Any
26 | Protected Network: 0.0.0.0/0
27 | IKE Over TCP: Never
Table 3 - VPN settings
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3.5.2. Telephone is operational in VPN enabled Mode.

Press “Mute button followed by PROCPSWD followed by #” to enter the craft procedures and
follow the above steps to program the VPN enabled telephone.

4. Configure VPN-IPSEC and VPN-SSL Gateways and Clients

For these Applications Notes, a Cisco ISR 2811 was used as the IPSEC gateway and a Cisco
ASA5510 was used as the SSL gateway.

4.1. Configuring the Cisco ISR 2811 for VPN-IPSEC support

Please refer to the Avaya Application Note Configuring an IPSec VPN Tunnel between Avaya
96xx Series IP Telephones and a Cisco 2811 ISR Router for details of VPN-IPSEC configuration
on the Cisco ISR 2811. This document is available at the following link
http://www.avaya.com/usa/resource/assets/applicationnotes/96xxVPNCiscolSR.pdf.

4.1.1. VPN-IPSEC client configuration

Install the VPN Client software on the Remote User PC. See the following link for details of
software download.

http://www.cisco.com/en/US/products/ps6496/tsd_products_support series_home.html.
Launch the VPN client software. Enter a suitable name for the Connection Entry, and
Description. Enter the IPSEC Gateway IP address as the Host. Select the Authentication tab.
Select Group Authentication and enter the Name and Password. This should match the
configuration of the Cisco ISR 2811. Refer to Section 4.1 above. Select Save.

# VPN Client | Properties for “vpnsite”

Connechion Entry: | SElE

Dezcrnption: |test

Ci5CO
Hast: [172.16.1.1
Authentication ] Tranzpart ] Backup Servers ] Dial-Up ]
f* Group Authentication ™ Mutual Group Authentication
M ame: |gru:uu|:uauthu:ur
FPaszword: | ******

xxxxxx

Confirm Pazsword: |

i Certificate Authentication

RET =S | J

™ Send Ca Certificate Chain

Eraze |leer Fazzword | Save | Cancel
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The User will be prompted for client login details. Refer to Section 4.1.

# status: Disconnected | VPN Client - Version 5.0.06.0110

Connection Entries  Status  Certificates Log  Options  Help
£ =
.@ =) T

Cancel Connect Mew Irmport hd ity Delete CISCO
Connection Entries | Certificates I Log I

I Connection Entry — / I Hoost Tranzport

ypnsite 172.16.1.1 IPSec/UDP
« | ]

| Authenticating user, ., (INEEENEEEEEEE

# YPN Client | User Authentication for “vpnsite® |g|

The zerver has reguested the following information to complete the user
authentication.

il | | ,|| 1, Uzermame: Itestphnne2
cISco

Pazzword: I“’“"“‘“

(] 4 I Cancel |

Select OK. Upon successful connection the following screen will be displayed.
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# status: Connected | ¥PM Client - Version 5.0.06.0110

Connection Entries  Status  Cerkificates Log Options Help

Connection Entries ]Certificates ! Log ]

-& e =) % 2 vl

Dizconnect [ ew Irmport kA adify Delete ClsScCoO

Connection Entry -/ Host Transport
vpnsite 172.16.1.1 IP5ec/UDP

<]

|»]

| Connected to "vpnsite”, [Connected Time: 0 day(s), 00:00.12

JE3]L

The Remote user PC will now be connected via VPN-IPSEC to the IPSEC gateway.
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4.2. Configuring the Cisco ASA 5510 for VPN-SSL support

It is assumed that Cisco ASA 5510 is installed and set with the necessary network connectivity.
[See Section 8.2 in this document for a copy of the running configuration]. This section
illustrates the main configuration steps for VPN-SSL support. Please also refer to online Cisco
documentation. Use the Cisco Adaptive Security Device Manager software to access and
configure the ASA 5510. See the link http://www.cisco.com/en/US/products/ps6121/index.html
for details.

4.2.1. Launch and Login ASDM Application

Connect a crossover network cable from a laptop to the Cisco ASA MGMT port. Use DHCP to
acquire an IP address. When launching the ASDM application the user may receive a Java error
as illustrated below, click OK to continue.

Error - Java _'_j o s )ﬂ

@ jawva,lang.MullPointerException
Ik |

¢

=2 Java” Loading...
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Select Yes to the security and certificate warnings. Log in to the ASA5510 using the appropriate

Cisco login credentials. Enter the IP address of the ASA5510. In this case, the default service IP
Address 192.168.1.1 is used. Select OK.

B2 Cisco ASDM-IDM Launcher ¥1.5(45) : o o] |

S, Cisco ASDM-IDM Launcher .20

Cisco

Devics IP Address | Name: [192,168.1.1 Ed
Username: |ciscu
Password: | EEEEF

[~ Rumin Demo Mode

Ok I Close |

8] |

When the ASDM application successfully logs in to the ASA 5510, the management screen will
be displayed. Select Configuration->Device Setup-> Interfaces.

[ Cisco ASDM 6.2 for ASA - 192.168.1.1

: — =lolx|
File View Tools ‘Wizards ‘Window Help Look For: Ibackup o ] I (M I ]
= . . .
@ Home IO% ConFiguratiol_';l @ Manitoring | G Save G Refresh | 0 Back d Forward | ? Help | W CISCO
Device List g oox Confiquration > Device Setup = Interfaces O
o add [ Delete & Connect -
B 135.64.186.13 l Interface | Mame | Enabled | SIBCUI’IEY | 1P Address | EyubF?elt ni‘?_it | Redundant | Member B se |
] 1 52, 166.1.1 = o - e T o |
Mo Ma Mo
Mo No Mo Lelete |
outside Yes 0172,16.1.5 255.255,255.0 Mo Mo I
a R ox Management0/0 manage, . Yes 100192,168,1.1 255.255,255.0 Mo Mo
= Dievice Mame/Passwaord
& System Time
&) Device Setup
g:{; Firewall
& Remote Access VPN 1 I I —.I
¥ Enable traffic between bwo o more interfaces which are configured with same security levels
Siterta-Site PR
= IV Enable traffic between two o more hosts connected to the same interface
Eg) Device Management
» Apply | Reset |
1 [eisco E | (&8 | | | & |i7nziesteesar e
Jﬂjstartl =1 B > [ Command Prompt I {7 My Documents I Y untitled - Paint II@ Cisco ASDM 6.2 for ... |§ WS e Bl R0E 151
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Add the Inside and Outside interfaces. Choose Add-> Interfaces. Input the details for the
interface. The image below illustrates an existing interface Ethernet0/0 in Edit mode.

| B= Edit Interface

135.64.186.13
|pSs.z55.255.224 0w
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Next create a static route for the inside interface. Select Routing—>Static Routes. Select Add.
Choose inside from the Interface drop down list. Enter 0.0.0.0 as the IP Address. Enter 0.0.0.0 as
the Netmask. Enter the Gateway IP in this sample configuration its 135.64.186.1. Select OK to
apply.

= Add Static Route =
Interface: Iinside LI
IP Address: [0.0.0.0 -] Metmask: f.0.0.0 |
Gateway IP: |135.64.186.1] ] metric: 1

Dpkions
i+ Mone

i Tunneled (Default tunnel gateway For YPR traffic)

" Tracked

Track: I0; I Track IF Address: I
=] I Tiarget Interface: Iinside - I

Manitoring Sptions |

Enabling the tracked option skarks a job for monitoring the state of the rouke,
by pinging the track address provided,

(] 4 I ancel I Help I

The following screen displays the configurations made. Select Apply.

-lBix
File View Tools Wizards Window Help Lok For; {backup Go
]

c% Configuration

@ Home @ Mnn\tnrlng‘ LB Save @Refrash| o Back \;) Fnrward| ? Help‘ i cisco
Device List & o8 ox
& add [ Delete 8 Connect

-3} 135,64.186.13
192.1“.1.1 Filter: (+ Botfe " IPvdaonly  IPvE only

Configuration > Device Setup > Routing > Static Routes

(]
Specify static routes,

Hetmask(

Interface | IP Address

Gateway 1P ME'[" Options il

0.0.0.0 Mone: Edit.
Device Setup o 8 X Delete
= Startup Wizard

Interfaces

Mulkicast

(39 Proxy ARPs

B GG Device Mame/Password
) System Time

Eﬁ) Device Setup

% g

g’é Remote Access VPN
Site-to-Gite ¥PI
EL Device Management

» Apply Resct

| |cisco o | & ||| A vz ez ot

i start B & » B command Prompt | ' v Documents | % untitled - paint |IE CiscoASDM 6.2 for .. |8 @ oo WR =10 B BLIG0 15
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Next step is the firewall configuration. Select Firewall from the lower left window. Select
Objects > Network Objects/Groups. Select Add > New Object. Enter a suitable Name. In
this sample configuration inside-network was used. Enter the IP Address and Netmask. This IP
Address range is that of the inside network, i.e. accessible to the Avaya telephony environment,

see the network diagram in Figure 1 in Section 1 above.

B Add Network Object x|

Mame (opkional): Iinside-netwnrk

IF Address:  |135.64.186.0
Netmask: ps5.255.255.224 |
Description: ||

K, I Zancel Help |

Repeat these steps to create an outside Network Object. In this case the IP Address range is what

the Remote User access’s from the outside world.

g% Add Network Object x|

Mame {optional): Iu:uutside-netwu:urk

IP Address:  [172.16.1.0
Metrriask: l255.255.255.|:| |
Descripkion: I

ol 4 I Zancel Help |

And finally create a pool Network object for the IP Address range used to assign addresses to

connecting VPN clients, in this case 10.10.97.0/24

g% Add Network Object x|

Mame (optional); Iippu:u:ul_anw:u:unnect

IP Address: [10.10.97.0
MNetmask: l255.255.255.|:| =
Descripbion: I

(] 4 I Zancel Help |
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The following screen displays the configurations made. Select Apply

File  View

[ Cisco ASDM 6.2 for ASA - 192.168.1.1

Tools  Wizards

Window  Help

Laok For: |backup Gao

=10l ]

@ Hame

0%} Configuration

@ IMonitaring | lB Save @ Refresh ‘ o Back. \\) Farward | ? Help |

MM
I cisco

Device List

o & X Configuration > Firewall > Objects > Network Objects/Groups

m|
% Add [ Delete & Cornect Gadd - @ ede ] oot | q
- 135 64. 186,13
S ] 192.168.1.1 | Filter: | Filter | Clear
Narne A‘l IF Address Metmask, Description |
= IPw4 Netwark Objects
- @ any 0.0.0.0 0.0.0.0
Firewall LI ~ BB nside-network. 135,64, 166.0 255,255 255,204
MAT Rules ;I ippool_anycaonect 10.10.587.0 picic ]
-~ Service Palicy Rules - ) management-network | 192.168.1.0 255,255,255,0
ﬁ: A28 Rlibs ‘af) o sice-netwark 172,16.1.0 755,755,255,

bR

228 Filter Rules
[l Public Servers
~=EF URL Filering Servers

-85 Threat Detection
E1-{F] Objects

I6f Service Groups
(lass Maps

[#}, Inspect Maps

{E Regular Expressions
[ TCP Maps

{B) Global Podls

L) Time Rranges
-1 Advanced

| K

&) Device Setup
gﬂ Firewal

gg Remote Access VPH

@ Site-to-Site PN

@ Device Management

iy

EFIPve Metwark Objects

@ any

o

Reset

‘ Ecisco

2

B
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The next step is to create Access Rules for the inside network interface. Select Add = Access
Rules. Configure rules for the inside interface. On the inside interface create a rule to the
specific pool, listed under destination.

@ addAccesshule x|

Interface:

Action: s Permit  { Deny

Source: Ianv _|

Destination Iippu:uul_anycu:unnect,l'24 _I |

Service: Iip I

Descripkion:

[+ Enable Logaging

Logging Level: IDeFauIt vl
More Options ¥
0] 4 I Cancel Help
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Note: It is useful to enable ICMP for debug purposes when configuring the ASA5510, hence
this is included in the set-up illustrated below.

& Cisco ASDM 6.2 for ASA - 192.168.1.1 L o ] 3
File Wiew Tools ‘Wizards ‘“Window Help Look For: |backup Go \ I " I \
= - s ! i [
@ Horne: O%} Configuration B Monitaring ‘ @ Save @ Refresh | 0 Bark .\) Forward | '?) Help ‘ l CIsCO
! a . s
Device List o B X Configuration = Firewall == Access Rules ]
M Fadd -|[HEdt Wocke 4+ & % B @ - QFrd EDiagram [GfExport - (§§ Clear Hits Show Log B Packet Trace
-8 135.64.186.13
. 11192.168.1.1 # | Enabled Source Destination Service Action Hits | Logging | Tims
B 5 inside {3 incoming rules)
0y ~ @ any L@ inside-network/27 el icrnp ° Permit a
2 M & oany 8 ippocl_anycoonectiz4 a6 ip o Permit | T 19...
Firewall a B X HE; @ any @ any 180 0p @ Ceny Irplicit rule
. ] ’mslde IPv6 (2 implicit incoming rules)
- (=3 NAT Rules 5% management (1 implicit incaming rules)
; } Service Policy Rules 5% management IPv6 (1 implicit incoming rules)
~o@ AR Rules = n ”
(0. 5] 1; nuts\d:y(z incoming rules) : ;
- Public Servers ! @ any o outside-networkiz4 et icp o Permit !
2B URL Filtering Servers 2 @ any @ any 1 0p @ Deny Implicit rule
54 Threat Detection outside IPve (1 implicit incoming rules)
Chjects
2 Advanced
&) Devire Sefup
%F ol
&g Remote Access YR
Site-to-Site WP 3 | |
Access Rule Type (8 1Pvd and [PYE ( IPw4 Only  IPwE Only
Q Device Management
w Apply | Reset I Advanced. . |
| Jcisco |z & | | B tehzios wnzTorute

** B Command Prompt

'/ start @ B e | () My Documertts I 14 untitled - Paint
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NAT was not required in this configuration so an exemption rule was created for the inside
interface. Select NAT Rules, select Add - Add NAT Exempt Rule. Select the inside for
interface from the drop down menu. Select ippool_anyconnect/24 as the Source. And for
Destination choose any. Select OK.

g% Add NAT Exempt Rule x|

Ackion: = E " Do ok exempt

Criginal
Interface: |insiu:|e j
SOurce; Iippl:n:ul_anycunnect,l'zdr _I

Destination: Iany

MNAT Exernpt Direction

{+ MAT Exempt outbound traffic From interface ‘inside’ to lower security inkerfaces (default)

" MaT Exernpt inbound traffic from interface 'inside’ to higher security inkerfaces

Descripkion
Ik I Cancel Help
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The following screen displays the NAT Rules configurations made. Select Apply.

&% Cisco ASDM 6.2 for ASA - 192.168.1.1 s =10l =l
File View Tools ‘Wizards ‘Window Help Laok For: Ibackup Go
7] : - il I (K1 I I
@ Home () Cnnﬁ_gurat!_nlj @ IMonitaring | Q Save G Refresh | 0 Back. \-; Forward | "? Help | CIsSCO

Device List o 2 X Configuration > Firewall > NAT Rules (|

Add Dielet: Ll {a
& [ Delete & Conned Foadd | @ Edt i Dokte | + + | 4 BB - afnd Disgram B Packet Trace
135.64,186.13
e h]192.168.1.1 . . I Original | Translated

YPE
Source Destination Service Interface Address SErvice L
K Exemnpt =8 ippool_anycoonecki24 @@ any {outbound)
Firewall g o ox [=] management 1 Dynamic rules)
i 433 Identiby @ any {outbound)
22 Filker Rules
{E Public Servers
L URL Filkering Servers
Threat Detection
Objects
o Advanced
gﬁ) Device Setup
g‘j Firgwiall
ﬁ Remate Access VPN
Site-to-Gite YR 4] | |
¥ Enahle traffic through the Firewall without address translation
@ Device Management
5 Apply | Reset |

| |cisco 2

&

| & |t7112109 1027537 LT

distart| [ B8 &
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Create a user account, this can be used to log in to the VPN-SSL connection. Select AAA/Local
Users > Local Users.

& Cisco ASDM 6.2 for ASA - 192.168.1.1 =1ox]
File ‘Wiew Tools ‘Wizards ‘Wwindow Help Loak For: Ibackup Go ' I {2 I '
L) L] L]
] N . 2 T Pors @
@ Home 0 Configuration @ Manitoring @ Save @ Refresh | o Back \} Forward | o.) Help | CIsSCO
Device List o B X Configuration > Remote Access ¥YPN = AAA/Local Users > Local Users O

g add ﬁ Delete ﬁ Connect

= 135.64.186.13

8 192.168. 1.1

Remote Access ¥PN o B X

? Introduction

etwork (Client) Access
Clientless 5L VPN Access
g Aanilocal Users

ﬁ AAA Server Groups
Fig LDAP Attribute Map

-—
& Secure Desktop Manager
B3 Certificate Management
Language Localization
|§’ DHCP Server

DS

Advanced

g.g Remote Access VPN

Site-ta-Gite YR

% Device Management

Create entries in the 454 local user database.
Command authorization must be enabled in order For the user account privileges to be enforced. To enable command authorization, go to EElasy

AA4 authentication console commands must be enabled in order For certain access restrictions ko be enforced. To enable Aaf authentication cormmand go

to Authentication,

enable_15

cisco z
massey a
test o

-- Inherit Group Folicy --

GrpPolicyAnyConnect
GrpPolicyAnyConnect

apply | Reset |

-- Inherit Group Policy --
-- Irherit Group Policy --
-- Inherit Group Policy --

Add

Edit

Delete

il

[cisco 2

C

Lt-‘startl =

** B Command Prompt

| |2} My Documents

| 4 untitled - Paint

NN; Reviewed:
SPOC 03/08/2010

Solution & Interoperability Test Lab Application Notes
©2010 Avaya Inc. All Rights Reserved.

|[F2 cisco aspMB2 for .. |8 @ o MBI D B BB 815

24 of 53
RmtUserAccVPN



Select Add. Enter a username in the Username, and a new password in the Password and
Confirm Password fields. Click OK.

F= Add User Account 3

Username: Iuserl

Password: I********

Confirm Password: I EEEEEEES

[ User authenticated using MSCHAR

Access Restriction

Select one of the options below to restrick ASDM, 55H, Telnet and Console access,
Mote: all users have network access, regardless of these settings,

{* Full access{AS0OM, 55H, Telnet and Consaole)
Privilege level is used with command authorization,

Privilege Level: E - I

= LI login prompt For S5H, Telnet and consale (no AS0M access)

This setting is effective only if AAA authenticate console command is configured.

" Mo ASDM, 55H, Telnet or Console access

This setting is effective only if AAA authenticate console command is configured.

| Find: I

@ PMlext ':_) Frevious
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Next, select VPN Policy, uncheck the Inherit box for the Group Policy, and select
GrpPolicyAnyConnect from the drop down list. Select OK.

F= Edit User Account i x|
=-Identity Check an Inherit checkbox to lek the corresponding setting take its value From the group policy.
Isroup Policy! lGeroIicyAnyConnect j I
Tunneling Protocols: ¥ Inherit [T Clientless G50 RN [T S50 YEN Client: [T IPsec [T L2TR[IRsec

IPv4 Filker: W Inherit I LI [Manage |
IPv& Filter: W Inherit I j Manage.. |
-

Connection Profile (Tunnel Group) Lock: v Inherit I _I

Store Password on Client System: V¥ Inhetic € Yes (O Bo

i_onneckion Settings

Access Hours: [+ Inherit I j Manage |

Simultaneous Logins: ¥ Inherit I
Maximum Connect Time: ¥ Inherit [~ Unlimited I [Minutes
Idle Timeaut: ¥ Inheric [~ Unlimited I IirLtes

Dedicated IP Address (Optional)

IP Address: | Subrigk Mask: I VI

i Find: I @ net @ Previous

OF I Cancel Help
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The following screen displays the configurations made. Select Apply.

% Cisco ASDM 6.2 for ASA - 192.168.1.1

L. ~=1ol x|
File Yiew Tools ‘Wizards ‘Window Help Look Far: (i}
: _ alialn
&
@ Home O% Configuration| | *] Monitoring ‘ B Save @ Refresh | o Back ‘\_) Forvweard ‘ “[) Help ‘ CISCO
Device List o B X Configuration > Remote Access ¥PM = AdA/Local Users > Local Users =

& add [ Delete S Cornect
o B 135,64,186,13

192.168.1.1

Create entries in the ASA local user database.

Command authorization must be enabled in order For the user accaunt privileges to be enforced. Ta enable command autharization, go to Authorization.

AAA authentication console commands must be enabled in order For certain access restrictions to be enforced. To enable 444 authentication command go ko

! DHCP

DNS

Authentication,
Remote Access.. o' B X Username Privilege Level (Role) | Access Restrictions | VPN Group Policy | PN Group Lack
Introduction nioel 0 Full GrpPolicyanyConnect -- Inherit Group Policy -
etwark (Clisnt) Access enable_15 15 Full MR NfA
lientless SSLYPN Access cisen 2 Ful - Inherit Group Palicy - - Inhert Group Policy - Delete
AndfLocal Users massey 0 Full GrpPolicyAnyConnect -- Inherit Group Policy --
i3l Aaa Server Groups

By LDAP Attribute Map

@ Secure Desktop Manager
Certificate Management
Language Localization

Server

Advanced

Eﬁ) Device Setup

g}} Firewall

| Remate

Access WPN

Site-to-Gite YPH

% Device Management
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On the same Configuration screen (not shown), create a connection profile. Select Remote
Access VPN from the lower left window. Select Network(Client) Access - AnyConnect
Connection Profiles. Select Add. Enter a Name and Alias. Select Annyconnect_addr_pool
from the Client Address Pools. Select GrpPolicyAnyConnect from the Group Policy drop
down list. Select OK.

F%& Add SSL ¥PN Connection Profile x|
s Narne: ITeIeworker
[H-Advanced
Aliases: IAnyconnect

Authentication

Method: = ans  Certificate ¢ Bath

A48 Server Group: ILOCAL LI Manage. ..

I | Use Local if Server Graup Fails

lient Address Assigment

DHCP Servers: I

Client Address Pools: Innyconnect_addrjool Select...

Client IPv6 Address Pools: I Select...

Default Group Policy

Group Policy: GrpPolicyanyConnect Manage. ..

il

(Following Field is an attribute of the group policy selected above. )

¥ Enable 551 ¥PM Client protocal

| Find: I @ next @ Previous

Ok I Cancel Help
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The following screen displays the configurations made. Verify that Access Interfaces and Login
Page Setting are ticked. Select Apply.

% Cisco ASDM 6.2 for ASA - 192.168.1.1 i

o [=]
File View Tools Wizards ‘Window Help Lok For: [backup =2 ||| |||
. I
Do @ - o - &
(@) Hore | 6 configuration| [2] Horitoring | ] seve Q@ rerest | ) sack () Forveard | n.) Help cisco
Device List o & X

Configuration > Remote Access YPN = Network {(Client) Access > AnyConnect Connection Profiles (]

@ Add @ Delete ﬁ e The security appliance atomatically deploys the Cisco AnyConnect YPR Clisnt or legacy S5L ¥P Client to remote users upon cannection, The initial clisnt

135.64.166.13 deployment requires end-user administrative rights, The Cisca AnyConnect ¥PN Client supports the HTTPS/TEP (55L) and Datagram Transport Layer
192.168.1.1 Security (DTLS) tunneling options.

{Mare cliant-relatad paramsters, such as disnt images and ient profiles, can be Found at STETEEEES,

Remaote Access YPN o 8 X Access Interfaces
Introduction | [ Enable Cisca AnyConnect WP Client or legacy SSLYPR Client access on the interfaces selected in the table below
| Netwark (Client) Access
Interface I Allow Access Enable DTLS I
IPsec Connection Profiles outside I ~
8% Group Policies inside ] r
|- % Dynamic Access Policies rnanagement O (]
AnyConnect Customization/Local
p Address Assignment
- % Advanced

Access Pork; I‘HS DTLS Part; 1443
Clisntless 551 YPN Access
AsdfLocal Users
Secure Desktop Manager

Click here to Assign Certificate to Interface,

Certificate Management [roipaceseing

Language Localization ¥ Allow user ko select connection profile, identified by its alias, on the login page, Gtherwise, Def aultWebYPNGroup wil be the connection profile.
CHCP Server e

DS Cannection Profiles

Connection profile (tunnel group) specifies haw user is authenticated and other parameters,

g‘ﬁpge“‘ce Setup % add | 2 Edt | [0 Deletel
ga Fireveall
|§2§ Remate Access YPM

Enabled Aliases Authentication Method

]
= Anyconnect ABBLOCALY
DefaultRAGraup [E] ABALOCAL)
&g Sike-to-Site YPN AnyeonneckTest ~ ARALOCAL)

@ Device Management

iy

Apply Reset
| disco |2

distart| (23 B8 € > B command Prompt | |5 My Documents | Y untided
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Edit the profile, ensure the Connection Alias and Group URL’s are enabled Select the user you
have created from the connection profiles. Select Edit. Expand the Advanced menu and select
SSL VPN. Add Connection Aliases and Group URLSs as illustrated below. Select OK.

ol
File Wiew Tools W B o
= ) I (] I LI}
@ Home a Canfig [™ Enable the display of Radius Reject-Message on the login screen when authentication is rejected H CISCO
Device List ™ Enable the display of Securld messages on the login screen O

4 add [ Delete 8
= 135.64.186.13

b8 o2 156.1.1

Remote Access ¥PN
—_—

Introduction
[} Metwork {Client) Acces:
sConneck Conn
)i IPsec Connection F
- sroup Palices

Drynarnic Access Po

% AnyConnect Cusko
-2 p Address Assigrimer
-7 Advanced
B Clientless 551 PN Acce
AdafLocal Users
h Secure Deskkop Manag
Certificate Managemen
Language Localization
DHCP Server
DNS

E

1
. Device Setup

Firewall

Sg Remote Access VF
Site-ta-Sits YR

El Device Manageme

-Client addres:
-Authenticatio

-Authorization

-Secondary Authentica

sing
n iConneckion Aliases

n. The initial client

Login Page Setting in the main panel ta complete the configuration.

This S5L YPM access method will present a list of aliases configured For all connection profiles. You must enable the

nspork Layer

b Add | @ Delete | {The table is in-line editable.) 0

|| —

Alias

Enabled
3

iaroup LRLs

This S5L ¥PM access method will automatically select the connection profile, without the need For user selection.

4 Add | @ Delete | {The table is in-line editable.) 0

Enabled

54, (IF a client connects using a connection alias, this setting is ignored. )

[ Find:_J

@ next @ Previous

o]

Cancel | Help |

r Do not run Cisco Secure Deskbop (C50) on client maching when using group URLs defined above to access the

tion profile,

ethod I

2/09 10:31:57 UTC

l'i;.‘startl =1 B * B8 Command Prompt

NN; Reviewed:

| {3} My Documents | ‘_ﬂ.l' untitled - Paint

SPOC 03/08/2010

|[F cisco aspME2 for .. B W o/ ML BT & BLGE 120

Solution & Interoperability Test Lab Application Notes

©2010 Avaya Inc. All Rights Reserved.

30 of 53
RmtUserAccVPN



Add a client image to the profile account. This is the package that is downloaded to the client
upon connection. Select Network(Client) Access - Advanced - SSL VPN - Client

Settings. Add an AnyConnect Client Image as illustrated below. This will be the VPN-SSL
client image downloaded by the Remote user when a connection is established.

[ Cisco ASDM 6.2 for ASA - 192.168.1.1

i =lol x|
File Miew Tools Wizards ‘Window Help Look For; [backup Go I I " I f

" [ (]
@ Hame U{}i} Canfiguration @ Monitoring ‘ o) oave @ Refrash | 0 Back d Farwward ‘ 01_) Help | CISCO
Device List o & Configuration > Remote Access ¥PN = Network (Client) Access > Advanced > S5L YPM > Client Settings ()
4 Add [ Delete & Connect

Remote Access YPN

B 135.64.186.13

B E]192.168.1.1

=)

Identify AmyConnect Client related files,

AmyConnect Client Images

The regular expression is used ta match the user-agent of a browser to an image.

You can also minimize connection setup time by maving the image used by the mast commonly encauntered operation system to the top of the list,

%Addl@ﬁdutl@os\sml -rl {-l

B ox

- Introduction

IPsec

4
g% Device Setup

A Advanced
Endpoint Security

i By

twark (Client) Access
tConnect Connection P
er Connection Profiles
Group Policies
Dynamic Access Policies
AryConneck Customization

B3 0L Manager
(5)- [ Clientless S5L VPN Access

Lo

-

Image Regular expression to match user-agent

S5L YPN Client Profiles

4 Add | @ e | T De‘etel

Hame Package

gﬂ Firewall

&S Remaote Access VPN

gg Site-to-Site YPH

@) Device Management

Apply Reset |

cisto 2

]

B 1711209 103257 UTC

]E‘Startl = =

> B Command Prompt

| {3 My Documents | 14 untitled - Pairk

Save the ASA5510 configuration. From the main menu select File=>Save (no shown).
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4.2.2. VPN-SSL client configuration

Launch a browser, and go to the URL https://ASA5510-OutsideGW _IPaddress. Select the
Group from the drop down list and enter the user name and password created in Section 4.2.1.
Select Login.

| | ] 55L ¥PN Service + |

il ssi VPN service
CISCO

Login
Flease enteryour username and password.

GROUP: f-Anir-cunnect-_\_r__g
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Upon successful login the following screen will be displayed. Select the AnyConnect tab.

.j https://172.16.1....5C0E+/portal.html

T SSL VPN Service

CISCO
| Corovee |

@ Horme : :
Address | hitp/l e ||

@IL feh Applications
@ Browse Metwarks

%G AnyConnect

Select Start AnyConnect.

l_i'| https://172.16.1....5COE+/portal.html
il gs) veN service
CIsSCO
[ @ Horme = — . .
Address | cifsn v || |
@} \Weh Applications
_@ Browse Metworks | AnyConnect
o AnvConnecﬁ
% %CI Start M siiliaet
b
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The SSL client image will be downloaded and launched.

I:] https://172.16.1....8COE+; portal.html

alrad SSL VPN Service
cisco

7 one barics (oo ][ ]
@ Wieb Applications E E
st $rsving
(£ Browse Networks WM. SSLVPN CLENT forWEBVPN
i %C' AnyConnect
The installer is launching Java ¥M detection.
Please wait...
rl
Useful Tips
Upon successful connection, the following screen will be displayed.
o Cisco S5ystems 55L ¥PN Client
Cugcn Svsrims
SSLVPN CLENT forWEBVPN
Statistics l R oute Details] About ]
Addrezz Information S55L Information
Server: 17216.1.5 Cipher: RC4 SHA-1
Client; 10109721 “ersion: TLSw1
Bytes Transport Information
Sent: 7225 Local LaM: Dizabled
Received: E7¥39 Split Tunneling: Dizabled
Frames Connection Information
Sent; 43 Tirne: 00:00; 35
Received: 42
Reset
Ciose ) Disconnect
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5. Logging in to Avaya one-X® Portal and Avaya one-X®
Communicator

Once the Remote Client PC is connected via VPN either the IPSEC or SSL option, the user can
then launch and connect one-X Portal and one-X Communicator.

5.1. Login Avaya one-X® Portal
Launch a web browser. Go to the URL https://IPAddressOfoneXPortalServer:9443/

AVAYA
onea>l

Avava one-X™ Portal

Please log on.

User name: ll

Password: I

7-2009 Avava, Inc. All Rights Rezerved.

Enter the login details. Select Log On.

Avaya one-X™ Portal

Please log on.

User name: I_l_.lser_ﬂl]l]gl]

Password: I- ssssss

@2007-2009 Avaya, Inc. All Rights Reserved,
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Select OK on the warning message displayed below. The Remote User can either enter a cell
phone number or home number for the Place and receive calls using field. In this example a cell

phone number is used for the audio path. Enter the phone number and select OK.

NN; Reviewed:
SPOC 03/08/2010

Welcome to Avaya one-X™ Portal... ?
Last login taday 2t 5124 PM

Your current presence settings and call controls:

& Home User_20090 | svermessage

ff Home Mode

Place and receive calls using: E@ FH0E TR RN - |

[1@ po not disturb [] use an additional phona:

You will still be able
to place outgoing
calls,

Erelie
|%1'f FO0ET MM NN

. &y If you select 'Other phone', make a test call after
logaing in to verify the selected telephone warks with the
Portal carrectly,

Please note that Emergency Call Handling is unavailable
for thiz option, You rmust use your awn telephone to
place emergency calls!

Sawve these Mode settings m W
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Upon successful login the following screen will be displayed. The Remote User can now use the
features available on Avaya one-X Portal.

e &
one>< = x |
: @ Home User_ 20090 ﬂ| Eniermessage

_ R =
i

{ | | Earername e numiber |£.I ': | :-_'

Contacts Yiew  Fauaritas w

Ordered By: Last Name _~

| You currently have no Fevorites. To add & Favorite, Search for & Contact,
{ right-click ar the Contact, and sefect "Add fo Faroriras"

e sanaTHo00nn alx @
= . - I
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5.2. Login Avaya one-X® Communicator
Launch the one-X Communicator application.

Check that the settings are correct. Select menu options from the top right hand corner and
choose Settings. Select Phone from the General Settings list, and confirm the correct IP
Address, i.e. CLAN IP Address, and confirm valid login details are entered. Select OK.
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Depending on the resources available, the Remote User can enable Video also, by selecting the
Enable Video Calls tick box. Video must be enabled on the station settings on the
Communication Manager, and the Remote User PC must have a working video camera
connected. These notes will illustrate a non-video login first. Enter a valid Extension and

Password and select Log On.

The user can select the audio endpoint from the Place and receive calls using drop down list. In
these notes My Computer is used. This option requires the USB headset attachment to be
connected to the Remote Users PC. Select Login and save settings.
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Upon successful login the following screen will be displayed. The Remote User can now use the
features available on one-X Communicator.
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With video enabled, the user should see the video screen displayed, as illustrated in the image
below.

Enter name or number

It is also possible to integrate one-X Communicator with one-X Portal. This would enable the
presence service in one-X communicator, illustrated in the images below. To integrate one-X
Communicator and one-X Portal, select menu options from the top right hand corner and choose
Settings.
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Select Account from the General Settings list. Ensure that Use one-X Portal account is ticked.
Enter the IP Address of the one-X Portal Server in the URL field. Enter the User name and
Password of a valid one-X Portal login. Select OK.

E

The login details are now changed to one-X Portal login credentials.

NN; Reviewed: Solution & Interoperability Test Lab Application Notes 42 of 53
SPOC 03/08/2010 ©2010 Avaya Inc. All Rights Reserved. RmtUserAccVPN



Once successfully logged in the Remote User can access presence status of other users. In the
image below, call logs for user Home User_20050 are displayed.
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6. Verification Steps

This section of the document details some steps the Remote User can use to verify the different
stages of connection to VPN.

6.1. Verify Access and Connection to VPN Host

The Remote User can verify connection to the VPN host by checking the status on the VPN
client application. It is assumed that the Remote User is aware of the correct IP address for the
VPN host, in these notes the IP addresses are listed in the network diagram, Figure 1: Network
Overview of Remote User Client Connection.

6.1.1. Verify VPN-IPSEC Connection

Confirm that the correct Host IP address is used. In these notes 172.16.1.1 was used. Confirm
the status of the connection at the bottom left and right hand side of the application window.

# status: Connected | VPN Client - Version 5.0.06.0110 =19

Conneckion Entries  Skatus  Certificates Log Options  Help

% i) B4 e

Digconnect Mew [t b odify Drelete CISCO

Connection Entries ]Eertificates ] Log ]

Connection Entry Huozt Tranzport
¥pnsite 1721611 IPSec/UDP

‘ | ]

Connected to "vpnsite", onnected Time: O day(s), 00:00.12 | w|

If the VPN connection fails, the Remote User should contact their IT administrator. If the login
credentials are incorrect, the application will indicate this. The Remote User should check the
details and/or contact their IT administrator.
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6.1.2. Verify VPN-SSL connection

On the SSL VPN Client application screen, confirm that the correct Host IP address is used. In
these notes 172.16.1.5 was used. Confirm the status of the connection. Check the Address

Information, Bytes Sent and Received and Connection Information which should indicate
connection time elapsed.

a Cisco S5ystems 551 ¥PN Client

Gsce SvsTims
SSLVPN CLENT for WEBVPN
Statistics l Rt Details] bt ]
Addresz Information S5L Information
Server: 17216.1.5 Cipher: RC4 SHAA
Clignt: 10.10.97.21 Werzion: TLSw1
Bytes Tranzport Information
Sent: 7225 Local Lah: Dizabled
Received: E738 Split Tunneling: Dizabled
Frames Connection Information
Sent: 43 Tirne: 00:00: 35
Received: 42
Reset
m Disconnect
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6.2. Verify Telephony Connection
To confirm the telephony connection, the Remote User can simply place a test call.

6.2.1. Verify Test Call Using one-X Communicator

Enter a number to dial. In these notes 20050 was used. Select the dial button, once the call is
answered, verify display and confirm the audio path.

~

Enter name or number
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6.2.2. Verify Test Call Using one-X Portal

Enter a number to dial, in these notes 20050 was used. Select the dial button. The one-X
Communicator will first dial the mobile number. Once that call is picked up the destination
number is dialed. Verify display and confirm the audio path.

NN; Reviewed:
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7. Additional References

Avaya references are available at http://support.avaya.com.
Avaya Aura™ Communication Manager:
1. Administering Avaya Aura™ Communication Manager, Doc 1D 03-300509
Avaya 9600 Series IP Telephone:
2. Avaya one-X™ Deskphone Edition for 9600 Series IP Telephones Administrator Guide
Release 3.1, Doc ID 16-300698
3. Avaya VPN Setup Guide for 9600 Series IP Telephones Release 3.1, Doc ID 16-602968
Cisco references available at http://www.cisco.com
4. Configuring Cisco VPN Client 3.x for Windows to I0S Using Local Extended
Authentication Document ID 20621
5. Cisco ASA 5510 configuration
http://www.cisco.com/en/US/prod/collateral/vpndevc/ps6032/ps6094/ps6120/prod_bro
chure0900aecd80402e39.html
6. Cisco I0S Debug Command Reference
http://www.cisco.com/en/US/docs/ios/debug/command/reference/db_book.html
7. Cisco 10S Security Command Reference
http://www.cisco.com/en/US/docs/ios/security/command/reference/sec_book.html
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8. Appendix
8.1. Cisco ASA5510 VPN-SSL Running-config

Cryptochecksum: €94681b6 05d14377 807f8fee 733448b3

. Saved

: Written by cisco at 10:14:21.947 UTC Thu Dec 17 2009
1

ASA Version 8.2(1)11
1
hostname Cisco5510
domain-name cisco5510.silstack.com
enable password 2KFQnbNIdl.2KYOU encrypted
passwd 2KFQnbNIdl.2KYOU encrypted
names
name 10.10.97.0 ippool_anycoonect
1
interface Ethernet0/0
nameif iInside
security-level 99
ip address 135.64.186.13 255.255.255.224

interface Ethernet0/1
shutdown

no nameif

no security-level

no ip address

1
interface Ethernet0/2

shutdown

no nameif

no security-level

no ip address

1

interface Ethernet0/3

nameif outside

security-level 0O

ip address 172.16.1.5 255.255.255.0
1
interface Management0/0

nameif management

security-level 100

ip address 192.168.1.1 255.255.255.0

management-only

1
boot system diskO:/asa821-11-k8.bin
ftp mode passive
dns server-group DefaultDNS

domain-name cisco5510.silstack.com
same-security-traffic permit inter-interface
same-security-traffic permit intra-interface
access-list inside.200 access_in extended permit icmp any any
access-list inside_access_in extended permit icmp any 135.64.186.0
255.255.255.224
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access-list inside_access_in extended permit ip any ippool anycoonect
255.255.255.0

access-list outside _access_in extended permit icmp any 172.16.1.0
255.255.255.0

access-list inside_access_in_1 remark test inside mgmt
access-list inside_access_in_1 extended permit ip any any
access-list inside_natO_outbound extended permit ip ippool_anycoonect
255.255.255.0 any

pager lines 24

logging enable

logging asdm informational

mtu inside 1500

mtu outside 1500

mtu management 1500

ip local pool Anyconnect addr_pool 10.10.97.20-10.10.97.200 mask
255.255.255.0

icmp unreachable rate-limit 1 burst-size 1

asdm image disk0:/asdm-623.bin

asdm location ippool_anycoonect 255.255.255.0 management

no asdm history enable

arp timeout 14400

nat (inside) 0 access-list inside_natO_outbound

nat (management) 0 0.0.0.0 0.0.0.0

access-group inside _access _in_1 in interface inside control-plane
access-group inside _access_in in interface inside

access-group outside_access _in in interface outside

route inside 0.0.0.0 0.0.0.0 135.64.186.1 1

timeout xlate 3:00:00

timeout conn 1:00:00 half-closed 0:10:00 udp 0:02:00 icmp 0:00:02
timeout sunrpc 0:10:00 h323 0:05:00 h225 1:00:00 mgcp 0:05:00 mgcp-pat
0:05:00

timeout sip 0:30:00 sip_media 0:02:00 sip-invite 0:03:00 sip-disconnect
0:02:00

timeout sip-provisional-media 0:02:00 uvauth 0:05:00 absolute
timeout tcp-proxy-reassembly 0:01:00

dynamic-access-policy-record DfltAccessPolicy

http server enable

http 192.168.1.0 255.255.255.0 management

http 135.64.0.0 255.255.0.0 inside

no snmp-server location

no snmp-server contact

snmp-server enable traps snmp authentication linkup linkdown coldstart
crypto ipsec security-association lifetime seconds 28800

crypto ipsec security-association lifetime kilobytes 4608000
client-update enable

telnet timeout 5

ssh timeout 5

console timeout O

management-access inside

dhcpd address 192.168.1.2-192.168.1.254 management

dhcpd enable management

1

threat-detection basic-threat

threat-detection statistics access-list

no threat-detection statistics tcp-intercept
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webvpn
enable outside
svc image diskO:/sslclient-win-1.1.4_.179.pkg 1
svc enable
tunnel-group-list enable
group-policy GrpPolicyAnyConnect internal
group-policy GrpPolicyAnyConnect attributes
vpn-tunnel-protocol svc webvpn
webvpn
url-list none
group-policy GroupPolicyl internal
group-policy GroupPolicyl attributes
vpn-tunnel-protocol IPSec 12tp-ipsec svc webvpn
username test password P4ttSyrm33SV8TYp encrypted privilege 0
username test attributes
vpn-group-policy GrpPolicyAnyConnect
username noel password hXr27LHvPVXRk2DE encrypted privilege 0
username noel attributes
vpn-group-policy GrpPolicyAnyConnect
username cisco password 3USUcOPFUIMCO4Jk encrypted
username massey password yzW2iYg.foPh/VgW encrypted privilege 0
username massey attributes
vpn-group-policy GrpPolicyAnyConnect
tunnel-group Defaul tWEBVPNGroup general-attributes
default-group-policy GroupPolicyl
tunnel-group Teleworker type remote-access
tunnel-group Teleworker general-attributes
address-pool (inside) Anyconnect addr_pool
address-pool Anyconnect_addr_pool
default-group-policy GrpPolicyAnyConnect
tunnel-group Teleworker webvpn-attributes
group-alias Anyconnect enable
group-url https://172.16.1.5/Anyconnect enable
tunnel-group AnyconnectTest type remote-access
tunnel-group AnyconnectTest general-attributes
default-group-policy GrpPolicyAnyConnect
1
class-map inspection_default
match default-inspection-traffic

1
policy-map type inspect dns preset_dns_map
parameters

message-length maximum 512
policy-map global policy
class inspection_default

inspect dns preset_dns_map

inspect ftp

inspect h323 h225

inspect h323 ras

inspect rsh

inspect rtsp

inspect esmtp

inspect sqlnet

inspect skinny
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inspect sunrpc
inspect xdmcp
inspect sip
inspect netbios
inspect tftp

éervice-policy global_policy global
prompt hostname context
Cryptochecksum:e94681b605d14377807f8fFee733448b3

: end
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